Excel Data

sis O

entering data, analyzing data, and displaying the

results. Understanding and accurately performing
these functions help the analyst organize data, recognize
trends, and generally gain insight into whatever situation
started the data gathering process. Although the main focus
of this book is on the tools Excel provides for data analysis,
it also explores the available methods for entering data and
displaying the analyzed results.

E xcel's functionality falls into three different categories:

Data Entry

When you group related data values in your worksheet,
you can use Excel's built-in tools to perform simple
functions such as summing or averaging related numeric
values, or to create charts to visually display data. Excel
also lets you create formulas to automatically calculate
results after a user inputs data into your worksheet, and
create custom macros, which perform repetitive tasks for
you. You can use PivotTables to cross-tabulate data that
you have stored in lists, and a PivotChart to graphically
display a PivotTable. Exel has advanced analysis tools to
perform more sophisticated data analysis.

The foundation of data analysis is data entry accuracy, which
directly impacts your results, and ultimately, your interpretation
of those results. Although manually typing data in a worksheet
to create a data list is the simplest method, you may find it the
most cumbersome when you must analyze a large amount of

data. Fortunately, you can gather data from other sources, such
as already created external databases, and import the data it
directly into your worksheet. You can also create data forms to
simplify the process of inputting data into specific columns.

Data Lists

In its simplest form, a data list is merely a group of common
values, such as items you want to purchase from the grocery
store. When you place this type of information in Excel, you
typically group related data values. For example, you place
grocery items in one column and the quantity of each item to
purchase in the next column. See Chapter 2 for more
information on working with data lists.

Data from External Sources

Excel interfaces with many different Microsoft Office programs,
making it possible to acquire data from external sources. One
simple way to do this is to copy and paste data; you can also
import text files directly into Excel. Typically, organizations
store large quantities of data in database files. You can perform
a database query to access an external database and import
the desired data values. See Chapter 5 for more information on
working with external data sources.

Data Forms

If you need to manually input data into Excel, you can simplify
the process by creating a data form, which consists of a
worksheet or a dialog box with fields into which a user can
input data. With a data form, you can request the specific data

values. You can also use VBA to verify that you have
appropriate data before entering it in the worksheet column.
See Chapter 10 for more information about the creation of
data forms and use of form controls.




Data Analysis

When you analyze data, you perform a function to compare

different values. Data analysis occurs when you do something as
simple as totaling the numeric values in a column or sorting a list

alphabetically. You can perform more complex comparisons by

creating formulas or by writing macros with the VBA editor.
Excel also provides a set of analysis tools that perform
complex analysis, such as calculating descriptive statistics.

Formula Creation

You can use formulas to create a custom calculation that
analyzes data values in a cell or series of cells. You create

operators, and the built-in functions available in Excel. See
Chapter 4 for more information about creating formulas, and
Appendix D for formula basics in Excel.

workbook using the VBA editor. See Chapter 9 for information
on creating custom VBA functions.

formulas using any combination of cell references, mathematical

You can also create custom functions that you can call from any

PivoiTables

You use PivotTables to perform a cross-tabulation of data,
which is summarizing data into one or more classifications.
PivotTables analyze data from both an Excel worksheet and
an external database all within the same table. Everything

in a PivotTable is dynamic, meaning that each time you
change a value, any corresponding cells update immediately.
See Chapter 7 for more information on working with
PivotTables.

Macro Creation

Because they combine a series of calculations that you want to

any tasks that you perform in Excel. You can create a macro by
recording a series of keystrokes or by manually coding the
macro using the VBA editor in Excel. See Chapter 9 for more
information on creating custom macros.

perform into one step, macros help you save time by automating

Analysis Tools

Excel provides several other analysis tools that you can use
with your data values, including conditional formatting,
which formats data based on specific criteria, filtering, and
even data validation. See Chapter 3 for built-in Excel data
analysis tools.

Excel's Add-in data analysis tools provide more complex
analysis of your data values. You can use these tools to
find moving averages, run an ANOVA analysis on your
data, or determine rank and percentile values. See Chapter
11 for more information about Add-ins.

Result Presentation

While Excel's analysis tools can provide detailed numeric
summaries of your data values, you can also use them to create
graphical representations of your data. After you analyze your
data, you have different options for displaying your results.

Chart Creation

In Excel, you can create charts, which provide a visual
representation of your data values. You can embed a chart
directly into a worksheet or create a separate chart sheet. Excel
provides fourteen different chart types, each of which has at
least two different subtypes or variations. After you determine
the desired chart type, you can customize it further by changing
such options as text fonts and font colors. See Chapter 6 for
more information on creating and customizing charts.

PivotCharts

PivotCharts combine all of the same functionality

of standard Excel charts with the dynamic characteristics
of PivotTables. The result is a graphic representation of a
PivotTable that updates whenever you change your data.
See Chapter 8 for more information on working with
PivotCharts.
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Excel Data

Types

The default data type that Excel assigns to a cell determines
the type of data analysis you can apply to it. For example,

a cell. When you input data, Excel automatically parses ! { ] C
most data analysis tools require numeric values; if you try

I n Excel, a data type refers to the type of value stored in
it and determines its data type. Excel recognizes three

different data types: text, numeric, and formula.

to use a text value, the tools return error messages.

Text data types contain letters for use as text or labels within a
worksheet. You typically place /abels in a worksheet to identify

values that contain a letter are text. For example, although
1.45E+05 contains a letter, Excel recognizes it as a number
expressed in scientific notation.

columns and rows that contain numeric values. However, not all

You can use any combination of letters and numbers in a cell as
long as the total number of characters in the cell does not exceed

32,000 characters. By default, when Excel determines that a cell
contains text, it left-justifies the entire contents of the cell.

You cannot perform any mathematical operations on a number
as long as the cell also contains text. For this reason, you may
want to consider separating text and numeric values into two
separate cells. If you want Excel to treat a numeric value, such
as Zip Code or Social Security Number, as text, you place an
apostrophe (") before the numeric value in the cell.

A numeric value is any number, percentage, currency, time, or
date value. By default, Excel formats all numeric values by
right-justifying them in the cell. Because Excel has a specific

method for storing date and time values, they are considered
numeric values. You can customize the look of numeric values
using the Number tab on the Format Cells dialog box.

Number

Excel allows nearly any number you can possibly type in a cell
within the range 2.250748585072E-308 to

of formats or use the six different built-in number formats to
customize how a number displays in a cell.

NuMEeRIC GHARACTERS

You can use any of the following characters to express a
numeric value:0123456789+,-()/$%.Ee. The
placement of the characters within the number is important.
For example, the letters E and e allow you to express large

in any other location, such as preceding a number E54, Excel
treats the cell contents as text.

1.797693486231E308. You can input numbers in a wide variety

numbers, such as 1,256,000.000,000 in a format that is easier
to display, 1.256E+07, called scientific notation. If you use an E

FRACTIONS

If you type a fraction in a cell without preceding it with a
number, Excel automatically converts it to a date. To avoid this
conversion, place an apostrophe (*) or zero (0) in front of it. No
matter what number precedes a fraction, you must leave a
space between the number and the fraction.

NuMmBER PRECISION

Excel only guarantees precision up to 15 digits and converts

any digits beyond 15 to zeros without rounding values up to

the nearest place. For example, Excel converts both
35,555,545,365,875,988 and 35,555,545,365,875,922 to
35,555,545,875,900. Obviously this limitation makes storing large
numbers, such as a 16-digit credit card number, in their entirety
difficult. To avoid truncating credit card numbers, you can format
cells as text or create a special number format. See the section
‘Create a Custom Number Format" for more information.




Numeric (continued)

Dates and Time

Excel uses the Western, formally called Gregorian, calendar as a
basis for all dates and times, and stores them as a combined
number. Dates are all sequential, whole numbers from 1 to
2958465. Excel stores times, which are all portions of the dates,
as decimal values. For example, if you type the value 12/05/02
4:00 PM in a cell, Excel stores it as the numeric value
37595.66667, where 37595 represents the date portion, and
.66667 represents the time.

You can apply any mathematical calculations to compare and
manipulate dates and time. For example, you can add, subtract,
or determine the elapsed time between two dates and times. The
cell's formatting determines how the date or time value displays.

DaTEs

Although a date displays in a cell on your worksheet, Excel
actually stores its numeric equivalent. Using the Western
calendar, Excel determines the number of days in each month.
For example, January always has 31 days, and February has 28
days with the exception of leap year.

Excel for Windows bases all dates on what is commonly referred
to as the 1900 date system, which recognizes 1/1/1900 as the
first date with a stored value of 1. The last date that Excel
recognizes is December 31, 9999 or 12/31/9999, which it stores
as 2958465. If you use Excel on a Macintosh computer, dates
are based on a 1904 date system, which means 1/1/1904 has a
value of 1 and 12/31/9999 has a value of 2957003.

Although the two operating systems use different date
systems, you can convert them when moving worksheets
between a Windows and a Macintosh computer. If

you open a Macintosh-created Excel (version 2.0 or later)
worksheet in Windows, the dates automatically convert
to the 1900 date format. Likewise, opening a
Windows-created worksheet on a Macintosh converts
dates to the 1904 system. You can also manually force
the date conversion in Excel for Windows by selecting the
1904 date system option on the Calculation tab of the
Options dialog box.

If you decide to use two-digit dates in Excel, you must
exercise caution when entering them. Excel interprets

two-digit years between 00 and 29 as the years 2000

though 2029. Excel interprets two-digit years between
30 and 99 as 1930 to 1999. To avoid errors, consider

always using a four-digit year.

TimEe

Excel stores all time values as decimal values between 0
and 0.99999999, with 12:00 midnight being 0, and
11:59:59 PM being 0.99999999. So a time that displays as
12:00 P.M. (noon) has a value of 0.5.

By default, Excel bases all times on a 24-hour clock,
commonly known as military time. This means that if you
enter 10:30 without an A.M. or P.M., Excel assumes you
mean 10:30 A.M. If you want 10:30 P.M., enter P.M. after the
time, or use the corresponding 24-hour clock value of 22:30.

You can create formulas within any cell of a worksheet to
evaluate data values in other cells within your worksheet. For
example, the following formula adds the numeric values in cells
A1 through A10 and displays the total in the cell containing the
formula.

=SUM ($A$1:$A%10)

You must always precede formulas with an equal sign, which
signals that what follows is a formula that Excel needs to
evaluate. You can use any of the built-in functions, mathematical
operators, constant values, and cell references to create a

formula. Although you can use any combination of
elements in a formula, the total number of characters in
the formula cannot exceed 1,024 characters.

Excel formats a cell based upon the resulting value of the
formula. For example, most formulas return a numeric
value; therefore, by default, Excel right-justifies the
returned value of numeric formula cells like other numeric
cells. See Chapter 4 for more information about creating
formulas in your worksheets. For more on formula basics,
see Appendix D.
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Locate a Value

in a Worksheet

o0 locate values that match specific criteria without

manually scrolling through a large list of data values,

you can use Excel's Find option. A data analyst can
quickly use this feature to find any number or word, such as
a region's sales forecast for the year or a salesman's name.

To narrow your search, you can match not only the
value in the Find what field, but also a specific

You simply enter what you want to search for in the Find formatting. For example, you can find a value that
what field in the Find and Replace dialog box. matches 145.34 and that displays in Arial Bold.
If you do not know the exact value you want to locate, you To specify formatting, click the Options button in the

can use one of two wildcard characters as part of the search.
You use either an asterisk (*) or a question mark (?) to
denote a missing character from a value. The question mark
represents one value. For example, if you enter a search
value of 1?4, Excel finds the values 104, 114, and any other
three digit number that matches the pattern. An asterisk
represents any number of missing characters. For example, . . . .
1*% finds not only the value 114,gbut also 1234, and 19%854. in the Find and Replace dialog box. When you click

. Find Next, Excel finds the text that matches the text in
Whep.y ou search, Excel ﬁnds: the first match for the . the Find what field and has the specified formatting.
specified pattern after the active cell. If the located cell is See the section "Create a Custorn Number Format"
not correct, you can repeat the search to find the next cell.

for more information about formatting options.
Locate a Value in a Worksheet

@ Click EditeoFind.

Find and Replace dialog box. Click the Format button
to display the Find Format dialog box. The Find
Format dialog box displays the formatting tabs that
you find in the Format Cells dialog box. Specify the
formatting for which you want to search and click OK.
The specified formatting displays in the Preview field

E3 Microsoft Excel - Book3

File | Edit | Wiew Insert Format  Tools Data  Window  Help - -8 X
Excel displays the Find and Replace O @ | thdoCobmndth vz @ = -l -0,
dialog box. arial | b Qo Chrl+x s BN EE L B
Al Copy Chrl
[ paste Chrly F | G | H =
1 Paste Special,.. _ 2002 Sales Fiqures (=
2 farch April May June July
3 |Ada Fill v B5 57474 §B194.83 1051492 $3467.87  $15,155.10
4 |Ande Clear y 11353018 $15950.27 $18270.36 §13,254.30  §22910.54
5 |Bake B $499583 §7.31592 $9E3E01 §11956.10 §14,276.19
6 |Bens SRS 1462774 $16947.63 §19267.92 §21,588.01 $23.908.10
7 |Carte Delete Sheet $8,108.05 $10428.14 $1274523 $355256  §17,388.41
g |Jens Move or Copy Sheet... 12,305.52 $14 52561 $1694570 §6543270  §21,585.88
n John - §8.192.74 $10512.83 $12832.52 §8.99000  §17.473.10
|‘M E St %29,06585 $31,385.94 §33706.05  $5,33945  §35.346.21
11 | Park GoTo... Chribs  P0072.88 §72.352.97  §7471306 0 §232345 0 §79.353.24
12 | Sam ¥ $696363 $928372 §11pB03.81 §13923590  §16,243.99

13 |Siman $0,53945  §7FEA9.54  FOSVORS J122959 72 §14/1981  §F ARG S4 $19,259.99

@ Type the value you want to locate in the
Find what field. A g ; o = = G

H Ta|
. 1 2002 Sales Figures
Use * to replace a series of charactersor | 2 January  Febryary March April May June July
? to rep'ace a Smg'e Character 3 Adams $123456  $3964 65 $557474  $3194.83 $051492  §3 46757 $15,155.10
4 |Anderson | $8,850.00 |$38 346.21 _|$13,630.18 §15580.27 1827036 $13254.30 $223910.54
5 |Baker $355.65 §22.91054  $4 99583 §7 315592  $9636.01 $11.956.10 $14 276.19

@ Click Find Next.

6 Benson .
o 7 Carter Find and Replace
ExctelhllocatesI the cell containing a S jeﬂsen Fd | Regsce |
matching value. ohnson | §3
. . . 10 dones 524 roduha:  [re—IO) =
Repeat step 3 to continue searching. 11 |Parker  $65
12 |Samuels | §4
When you find the correct value, click E \i‘;ﬂ?n J: Optians >3
Close to close the dialog box. TE TWison

15 Wilsan  §13 Find Al | Eind Next |<—G‘9| =
Lo




Select a
Range of Cells

ou can make modifications to several cells in a

worksheet simultaneously, a process referred to

as selecting a range of cells, by choosing all the
related cells together before implementing the changes.
Typically, you select a range of cells to apply different
formatting options, to copy cells, or to change the Excel
value type. The range of cells does not need to be
contiguous; you can select cells from different locations
in a worksheet. See the section "Copy and Paste a
Range of Cells" for information on copying a range of
cells. See the section "Create a Custom Number Format"
for more information on formatting cells.

You can select anywhere from a single cell to the
entire worksheet. Excel highlights the group of cells
to remind you of your selection. If you select multiple
ranges of cells simultaneously, Excel highlights each
selected range.

To select an entire row or column, you simply click the
corresponding identifier. For example, to select all cells in
column C, you click the C identifier for the column. To
select multiple columns, you click the first column and then
continue holding down the mouse button as you drag to
the other columns you want to select. To select entire rows,
you click the row identifiers on the left side of each row.

You can select a smaller group of cells by clicking a cell in
one corner of the desired selection range, holding down
the mouse button, and dragging until you select the
desired range.

To select a noncontiguous range of cells, select the first
block of cells, and then press the Ctrl key and select the next
block. If you do not hold down the Ctrl key, Excel unselects
the first range of cells when you select a new range of cells.

Select a Range of Cells

0 Click the corner of the first block of cells.

E3 Microsoft Excel - Annual Expenses.xls [Group] E|@|E|

E‘B Flle Edit “ew Insert Format Tools Data  ‘Window  Help - & X
@ Drag the mouse to highlight the desired cells. | 0 =@ e SRy & &@- < s . PE? 0
3R x 5C - £ 780
@ Press Ctrl. A B[ ¢ [ © [ E T F T © H =
1 Monthlz Eernses
9 Select the next block of cells. 2 Rent Groceries Fuel Electricity Child Care Misc. Totals
3 % $750.00  §214.00 $75.00 $37.00 $110.00  $175.00 $1,411.00
4 Mbwany | = 3 = = 0 145 §1,493.00
Repeat steps 3 and 4 to select all cell blocks. E‘M“h E{P?su A 110 123 §1.417.00
8 |April 750 256 mol 211 $1,509.00
7 May $750.00  §307.00 $100.00 $110.00 F110.00  $34500 §1,722.00
8 June a0 350 i) 120 110 149 $1,554.00
9 July 750 310 G4 145 110 190 §1,599.00
10 August 750 299 110 130 110 256 §1,655.00
11 September 750 245 120 111 10 298 $1/534.00
12 October 750 280 99 98 110 245 §1,582.00
13 November 750 400 110 & 10 405 $1,863.00
14 December 750 415 130 a4 110 BO05 | §2,094.00

15

Excel highlights each of the selected cell

E3 Microsoft Excel - Annual Expenses.xls [Group] E|@|E|

b|0CkS E‘B Flle Edit “ew Insert Format Tools Data  ‘Window  Help - & X
' DEeEan ERY 2RI z - HE7 w02
Any changes you make affect only the EB - £ 120
highlighted cells. A B T ¢ [ o T ET F G H =
1 Monthly Expenses
2 Rent Groceries Fuel Electricity Child Care Misc. Totals
3 January §750.00  §21400  §75.00 $57.00 $110.00  §175.00 §$1,411.00
. 4 |February 750 31 (= 5] 89 110 145 §1,493.00
. 5 |March 750 245 90 23l 110 123 §1,417.00
& |April ?5% 256 79 1031 10 211 $1,509.00
7 May $750.00y $307.00 $100.00  $110.00 $110.00  §345.00 §1,722.00
g |June 750 350 =<1 110 149 §1,564.00
9 |[July 750 310 94 145 110 190 §1,599,00
10 |August 750 299 110 130 110 256 §1,655.00
11 |September 750 245 120 111 10 298 $1,634.00
12 |October 750 280 2] 98 110 245 §1,532.00
13 [November 750 400 1o 55 110 405 $1,653.00
14 |December 750 415 130 B4 10 B05 $2,094.00
15
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f you need to reference a specific range of cells in

multiple locations, it can become tedious to remember

the cell locations. You can create range names to easily
locate specific information, to avoid having to remember the
cell locations, and for use in any formulas that you create.
For example, if you create a range name in Sheet1 named
Sales_Amounts, in Sheet2 you can create a formula that
sums the range by typing the following:

=SUM (Sales_Amounts)

Using the named range eliminates the need to specify a
worksheet or cell reference. Although the example shows
how to access a range from any worksheet in the same
workbook, you can also reference a named range of cells
from another workbook. For example,

=SUM (Sales2002!Sales Amount) references a named
range in the workbook Sales2002.xls. See Chapter 4 for
more information on creating formulas.

You create the range name in the Define Range dialog box.
Your range names can consist of up to 255 characters, but
you only see about the first 16 characters of the name in
the Name box. Therefore, you may want to use names that
you can easily distinguish after viewing the first few
characters.

Excel only allows you to use a range name once in a
workbook; therefore, if you have a duplicate name in
another worksheet, you must use a different name. If you
create a range name that already exists, Excel replaces the
previously specified range with the new range. To avoid
potential errors, verify that you have a unique range name
before using it.

If you duplicate a worksheet containing a named range,
Excel only recognizes the range name in the original
worksheet for other worksheets in the workbook. You can
only access the copied range name on the copied worksheet.

Ed Microsoft Excel - OfficeExpenses.xls
@ Select the range of cells that you want to ®) be Gk Gon Deot Fgmet Imb Data Wndow b =T
fdre: DEHas8 SRY BRI o- -4 mea2 0 -7
B3 - fx 350
: " " A B c D 1= F ] H 1 =
Note: See the section "Select a Range of Cells : [ B ] Office Expenses =
for more information on selecting a range. 2 Rent Advertising Phone ISP Parking | Misc.
3 January $350.00 40000  $200.00 $110.00  $5000 $175.00
4 |February $350.00 $350.00  §240.00 §110.00 $50.000 $145.00
5 |March $350.00 $55000  $31000  $110.00  $5000 $123.00
B |April £350.00 F725.00 §250.00 §110.00 $50.000 $211.00
7 $350.00 $E00.00  §24500 $110.00 $50.000 $345.00
in—b $350.00 79500 $310.00  $110.00  $50.00 $149.00
9 July $350.00 FE00.00  §340.00  §110.00 50000 $120.00
|10 |August $350.00 $91000  $21500  $110.00  $5000 $256.00
| 11 |September | $350.00 $845.00 &400.00 §110.00 $50.00 $298.00
12 |October $350.00 $7E5000 §450.00  $110.00 $50.00 $245.00
| 13 |November £350.00 FO00.00 46500  §110.00 $50.00  $405.00
| 14 |December .00 $1,005.00 §500.00 §$110.00 $50.00  $B05.00

fr

@ Click Insert=>Name=>Define. 4 Microsoft

Excel - OfficeExpenses. xls

L
m

Q File Edt  Yiew | [nsert ._ Formak  Tools  Data  Window  Help -8 X
== | Rows Lol -2 ael? v -3
B3 - Columns
A . Warksheet D E F G H I =
1 [ char... Expenses M
2 Rei Phone ISP Parking Misc.
| 3 [January g fx Eunction... $20000  §110.00 %5 $175.00
| 4 |February Sjl_ Marne 3 cf ! $145.00
5 |March 8 Diagram ¢ 00 $5000 $123.00
B |April g . 00 $5000 §211.00
7 |may $oopooy— pooooo|  Creste.. 0 §5000) $345.00
| & |June $350.00 $725.00 oo $50.00 0 $149.00
9 July $350.00 $E00.00 — oo $50.00  $190.00
| 10 |August $350.00 $910.00 = 00 $50.00 $256.00
| 11 |September | $350.00 $845.00 $400.00  §110.00 $50.00  §298.00
12 |October $350.00 $705.00  $450.00  $110.00 5000 $245.00
| 13 |November $350.00 FO00.00  S46500  §110.00 $50.00  $405.00
| 14 |December $350.000 §1,005.00 $500.00 $110.00 $50.00  $B05.00




The Define Name dialog box
displays.

Define Name

9 Type the name of the range.

You can click the Collapse
Dialog button to make a
previously assigned range
appear in the Refers to box.

@ Click OK.

Mames in workbogls
|Rent<—§ |
J Close
Add
Delete
.
Refers to:

|=sheet 114643:465 14 <—

Excel creates the new range

name.
] Bie  Edit Wew Insert

@ You can click next to the
Name field to see the current [=] A

DEeEdasm Sy & 6B

Ed Microsoft Excel - OfficeExpenses. xls

Format  Tools Data  Window  Help

<f e .
793

2=-4 @A 0 -

range names. Fent Al B

¢c | o | E | F | &

Office Expenses

2 Rent Adwvertising Phone ISP Parking Misc.

3 January @ %350.00 §400.00 §20000 $11000  %50.00  $175.00
4 |Fehruary $350.00 §350.00 24000 §11000  §50.00  $145.00
5 March $350.00 55000 §310.00 §11000  §50.00  $123.00
B |April $350.DD| $?95.DD_| $250.00  $11000  $50.00  $211.00
7 May $350.00 $800.000 $24500 $110.00  $50.00  §345.00
g |June $350.00 §795.00  §310.00 $11000  §50.00  $149.00
2 July $350.00 $600.00  §340.00 $110000  $50.00  $190.00
10 August $350.00 $910.00  $21500 $110.00  $50.00 §266.00
11 September  $350.00 §545.00 §40000 §11000  §50.00  $2595.00
12 October $350.00 F765.00  §45000 §11000  §50.00  $245.00
13 MNovember $350.00 §900.00 §46500 $11000  $50.00  $405.00
14 December $350.00  $100500 $500.00 §$110000 50,00  $605.00

H

s

If you no longer want to use a named range,
you can delete it by clicking Insert=>Name=>
Define. In the Define Names dialog box,
select the range name and click Delete.

When you delete a named range, you only
remove the name. The cells referenced by
the name remain unchanged. If you have a
formula that references the deleted range
name, the error #NAME ? displays in the cell
containing the reference. You must update
each formula that references the deleted
range name.

If you have a worksheet that includes
formulas that reference cells from a named
range, you can convert the cell references to
the range name. To do so, select the cells
containing the formula and click Insert=>
Name=>Apply to display the Apply Names
dialog box. The dialog box displays the
names that exist within the workbook. Click
OK to update the formula in the selected cell
to include the named ranges.

Keep in mind that Excel only updates the
range names within the existing worksheet
and not those in other worksheets.
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Create Label

Ranges

ou can automatically have Excel use the column or
row labels as the range names for your worksheet.
This eliminates time required to manually create a

rows contain the corresponding data values, you must
select both the labels and the data values. When you
activate this option, Excel creates a separate range name for

range for each column or row of data in your worksheet.
Excel creates names based upon the labels in the top row,
bottom row, left column, or right column within the range
of cells. For example, if your worksheet contains various
office expenses for an entire year, you can create named
ranges of monthly expenses. If the month names are in the
left column, Excel creates the range name from the left

column labels.

In the Create Names dialog box you must first select the
range of cells containing both the labels and the cells for
the named ranges. For example, if your top row contains
the column names for the worksheet, and the remaining

Create Label Ranges

each label within the range of selected cells.

If you have labels in the top row and the left column, and
you select the top row option, Excel only creates range
names for the top row. If you want to create range names
for both the top row and left column, you must select both
options in the Create Names dialog box.

Although Excel uses your worksheet labels to create the
range names, only the selected cells become a part of the

corresponding range. For example, if column C contains

telephone expenses, but you only selected a range of cells
that contained rows 1 through 12, Excel does not create a
range for the any values beyond row 12.

@ Sclect the range of cells containing labels.

@ File Edt  Wiew [nsert  Formak  Tools  Data Window  Help -8 X
DEdsasn &LV ¥ B <t B E-2300BH27 0 -7
Note: See the section "Select a Range of Cells" 13R%7C 'I ﬁrl | | |
f : : A B C D E F G H |
for more information on selecting a range. i Rent — Adverising Phone 5P Farking Wisc. )=
| 2 [January £350.00 F400.00 $200.00 §110.00 $5000 $175.00
3 |February $350.00 $350.00 $24000 $110.00 $50.00  $145.00
4 |March $350.00 $550.00 $310.00 §110.00  $50.00 $123.00
E|Apr]l $350.00 $795.00 $250.00 §110.00 $50.00  $211.00
6 |May $350.00 $800.00 $24500 $110.00  $50.00 $345.00
| 7 |[June §350.00 $795.00 $310.00 §110.00 $50.00 $149.00 4—0
g [July $350.00 $600.00 $34000 $110.00  $50.00 $190.00
| 9 |August £350.00 91000 $21500 §110.00  $50.00 $256.00
10 |September  $350.00 $845.00 §400.00 §110.00 $50.00 $296.00
11 [October $350.00 $765.00 $450.00 $110.00  $50.00 $245.00
12 |Movember §350.00 FO00.00 $46500 §110.00 $50.00  $405.00
13 |December §360.00  $100500 $500.00  $110.00  $50.00  $6000

@) Click Insert=>Namer>Create.

Ed Microsoft Excel - BusExpenses.xls

14
15

Ed Microsoft Excel - BusExpenses.xls

@ File Edb  Yiew | Insert ._ Formak  Tools  Data  Window  Help -8 X
Dedsn Rows < wE-2l5 maH0E7 0 -7
Al - Columns

A wiorksheet b | E F [ & H [~

1] Relu Chart... Phone ISP Parking Misc. |
| 2 [January ¥ — $200.00 $110.00 $50.00 $175.00
3 |February § £ Eunction... $240.00  $110.00 $50.00  $145.00
i'March !\l_ Name ,| Define... 0 §50.00  $123.00
5 |April - - 0 $50.00 $211.00
6 |May g f.f Diagram... Beste... o § $345.00
7 |June Sl ¥ o[ g |Ead% §149.00
g |July $350.00 $600.00 iy 00 $5000 $190.00
| 9 |August §350.00 $910.00 0 5000 $256.00
10 [September  $350.00 §845.00 Label... 0 $5000 $298.00
11 |October $350.00 §765.00 $450.00 §$110.00  $50.00 $245.00
12 |November $350.00 $000.00 $465.00 §110.00 $50.00 $405.00
13 |December  $350.00  $1005.00 $500.00  $110.00  $50.00  $s05.00

14

15




The Create Names dialog box - (@)
Create N

displays. reate Names [?[X] g
Create names in =

@ Click the option corresponding V' Top row =
to the location of the labels. 3 I Left column L

[ Bottom row .

o Click OK. I Right column .o

4 ,Tl Cancel

Ed Microsoft Excel - BusExpenses.xls

File Edit Wiew Insert Format  Tools  Data  window  Help - g X
DEESn &Y % B < B E-2l3l BT 0 -7
A1 f
Advertising B | c [ b | E | F | 6 H ]
ISP Rent Advertising Phone ISP Parking Misc. M
Excel creates th Misc. §35000  $40000 520000 $110.00  $5000 $175.00
A e e ing §35000  §35000 $24000 $110.00  $5000  §145.00
. . Phone §35000  §550.00 $31000 $110.00  §5000  §123.00
Click next to the Name field §35000  $79500 $25000 $110.00  §5000 §211.00

to see the current range
names.

$350.00 300,00 $24500  §110.00  $30.00  $345.00
$350.00 579500 $310.00 §$110.00  §50.00  $149.00
$350.00 60000 $340.00  §110.00  §50.00  $120.00
$350.00 91000 $215.00 §110.00  §50.00 $256.00
$350.00 F345.00 $400.00 §$110.00  §50.00  $293.00
$350.00 /6500 $450.00 §110.00  §50.00  $245.00
$350.00 F900.00  $465.00 $110.00  §50.00  $405.00
$350.00  §100500  $500.00  $110.00  $50.00  $505.00
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You can quickly eliminate any unwanted You can change a range from the Define

named ranges using the Define Name dialog Name dialog box by selecting the desired
box, which you display by clicking range, specifying the range of cells in the
InserttvNamer> Define. The Define Name Refers To field, and clicking Add. To create a
dialog box lists all of the names defined new range of cells, type the new range name
within the current workbook. To delete a in the Names in workbook field, specify the
named range, click it and then click Delete. desired range in the Refers To field, and
Excel only deletes the range name. It does click Add. You can use dates as the names
not delete any data. for your ranges. However, if your labels are

numeric dates, Excel must reformat the label
to match the name rules. For example,
1/31/2002 begins with a number and
contains a slash character, which you cannot
use in range names. If this date exists in a
label column that you use to create names,
Excel changes the range name to
_1_31_2002. See the section "Name a
Range" for more on naming ranges. See
Excel Help for specific range naming rules.




Modify Named

Ranges

the stored named range whenever you refer to it with

the assigned range name. If you change the
worksheet by adding or removing corresponding data values,
you must update the corresponding named ranges so that
Excel references the appropriate cells when you use that range
name. To create named ranges, and for more on the benefits
of using them, see the section "Create Label Ranges."

When you modify a named range, the changes affect every
location that refers to the corresponding range. For
example, if you create a formula that uses a specific named
range, and then change the cells that the range name
references by deleting a column of data, the formula
continues to reference the new version of the named range.
See Chapter 4 for more information on creating formulas.

Modify Named Ranges

A fter you create a named range, Excel continues to use

You use the Define Names dialog box to modify a named
range. In this dialog box, you select the desired range name
and make the appropriate modifications either by entering
them in the Refers to field or by using the Collapse Dialog
button to select a new range of cells. If you have multiple
ranges to modify, you can use the Add button to save the
changes to the first named range and then modify the next
range name.

If you change the actual range name in the Define Names
dialog box, Excel actually creates a new range name and
keeps the old range name. You can delete the old range
name using the Delete button. See "Create Label Ranges" for
information on deleting a range name.

B3 Microsoft Excel - BusExpenses.xls

@ Click Insert=oNamexDefine.

Create...

Fle Edt Yew | Insert | Formst Tooks Data ‘window  Help - _ 8 X
bD=EES" LA |- S =25 i) 0 -7
- Columnns
iy B Winrksheet ] E F €] H | =
1 Rent {1l chat e ISP Parking Misc. I
2 173172002 §35 i 00.00  $110.00 $a0.00  $175.00
3 2/28/2002  §35( £ Eunckion... ED.DD §110.00 $20.00  $145.00
4 3312002 535 | Nare N | Definel, | 123.00
5 4/302002  §350— 50,00 F211.00
5 %, Diagram... Paste. ..
7 b
3
9

Apply. ..
Label...

Mames in workbook:

s
—- O

The Define Name dialog box
displays.

@ Click the name of the range you
want to modify.

|F‘arkjng

o |
5P Sheet2 j

Close

fdd
May
Misc, Shest2 J LeEs

Mowvember

@ Click the Collapse Content button.

Refers ka:

|=sheetzi4F 42 4F$13

(&)



The corresponding cells in the
selected range display.

@ Change the range selection.
Note: See the section "Select a

Range of Cells" for more
information.

6 Click the Restore dialog button.

The revised range selection
displays in the Refers to

=] File

Edit  Miew

Insert

Format

Define Name - Refers to:

Tools  Data  Window Help

A

(Culim s s R m R B RN Y N

1/31/2002  $350.00 $400.00 §200.00 $110.00)  §$50.00) $175.00
2/28/2002 535000 %$350.00 %$24000 $110.00) $50.00% $145.00
3/31/2002 $350.00 $550.00 $310.00 $110.00) $50.00; %$123.00
4/30/2002 §$350.00 §795.00 $250.00 $110.00% _ §5AA0) $211.00

4R x 1T

field. Mames in workbook:
. |Parkjng | Ok [*l; ‘—e
O Click Add to update the saved e Shestz ] "
January Close
range. Ty
. June e—> Add
o Click OK. March =
IMay
. Misc, SheetZJ m
Excel saves the revised range. Movember
Cckober
Parking Sheetz ﬂ
Refers kos
|=shestz1gF 42 $F 45— |

When you have several different named ranges in a workbook, you may find it difficult
to keep track of them all. Excel provides a feature that quickly creates a list of all

names and the corresponding cell ranges. To create the list of named ranges, click
Insertc>Namer>Paste. In the Paste Name dialog box, click the Paste List button. Excel
creates a list with the first column containing the range names, and the second column
identifying the corresponding cell ranges. For example, if cells B2 through B10 contain
your advertising expenses, Excel pastes values similar to the following:

Advertising =Sheet1!3$B$2:3$BS12

The range reference simply identifies the cells within the named range. Excel first lists
the name of the worksheet containing the range and then the cells within the range. See
Appendix D for more information on cell references.

Excel places the list in your active worksheet starting in the cell containing your cursor.
Therefore, it is a good idea to place your cursor in a blank cell with plenty of blank cells
below it. Excel places no links in the list, so to keep it up-to-date, you must re-create it
whenever you change the named ranges.

1 1dey)
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Copy and Paste

a Range of Cells

f you want to use the same values in multiple locations, worksheet, including copying another range of cells,
instead of retyping, you can copy and paste. For example, ~ inserting cells, or hiding rows.
you may want to copy a data list for use in another report, After you copy a range of cells, you can paste the cell

or duplicate a formula in multiple cells. You can repeat contents at any location within your current workbook,
information within Excel using the Copy and Paste options. another Excel workbook, or any other Microsoft Windows
When you copy a cell or range of cells, Excel duplicates program. Excel replaces the content of the cells where you
everything in the cell — including the cell values, formulas, paste with the copied values. You can paste the copied cells

formatting, comments, and data validation — and leaves the as long as you have not copied another range of cells or
original cell values unchanged. You can multiple cells so long  until you close Excel.

as they are adjacent. You cannot copy multiple cell ranges. Be careful when you paste the copied cells. The best method

When you apply the Copy command to a range of cells, is to select the first cell where you want to paste the

Excel surrounds the cells with a dotted line. The selected contents of the cells and then apply the Paste command. If
cells remain marked until you perform a task that deselects  you attempt to select the entire range of cells where you
them. You can quickly press the Esc key to deselect cells. want Excel to paste the contents and do not select the exact
You can also apply menu options that change the number of cells, you receive an error message.

Copy a Range of Cells

Ed Microsoft Excel - Monthly Expenses.xis _____ [[§K

a Select the Ce”s yOU Want tO COpy. IZ!B Elle | Edit | Wew Insert Formst  Tools Data  Window  Help change sheet name -8 X
O & |9 UndoFormatcels culz L ga . <f o - @ = -4 %P ron -3,
Note: See the section "Select a Range of Cells" e B R .
for more information L G 2 2
. —— oy Monthly Expenses _
A q - . Fuel Electricity Child Care Misc. Total

9 Click Edit=>Copy. DTy §75.00  $87.00  §11000  $17500 $1,411.00

Show Date $98.00  S8000  §11000 14500 $1.493.00

icki . 59000 $9900 11000 §123.00 §1,417.00

You can also copy by clicking the Copy Fil , 900 $10300  $11000  $211.00 $150900

button (E]). Clear »|  $10000  $11000  $17000  $345.00 §1722.00

Delete... $95.00 12000 511000 $149.00 $1564.000

5400 §145.00  §110.00  $100.00 §1,590.00

DEEE e $110.00 $13000  $11000  $256.00 $1555.00

GaTo... ChrG $120.00 11100 $11000  $298.00 §1634.00

¥ 59900 S9BO0 11000 §24500 §1,532.00

13 November  §75000)  $400.00 $110.00 §56.00 $110.00 $405.00 $1,563.00
14 |December $750.00 $415.00 $130.00 §34.00 $110.00 $505.00 $2,094.00
15

Excel displays a dotted line around the E3 Microsoft Excel - Monthly Expenses. xls EEX
COpied Ce”S. E‘B File Edit ‘ew Insert Formst Tools Dakta  ‘Window  Help change sheet name - o F X

Dedan @RV BRI o @ = -4 3P e -3,

A2 - 3
A [ B [ ¢ [ D E [ F [ & [ H =

1 Monthly Expenses

2 Rent Groceries Fuel Electricity Child Care Misc. Total

3 January $750.00 $214.00 $75.00 §37.00 $110.00 $175.00 $1,411.00

4 |February $750.00 $311.00 $56.00 §89.00 $110.00 $145.00 $1,493.00

5 March $750.00 §245.00 $90.00 §99.00 $110.00 $123.00 $1,417.00

6 [April $750.00 $256.00 $79.00 $103.00 $110.00 $211.00 $1,509.00

7 May $750.00 $307.00 $100.00 $110.00 $110.00 $345.00 $1,722.00

g Wune $750.00 $350.00 $85.00 $120.00 $110.00 $143.00 §1,564.00

9 [July $750.00 $310.00 34,00 $145.00 $110.00 $190.00 §1,599,005.79

10 August $750.00 §295.00 $110.00 $130.00 $110.00 $256.00 §1,655.00

11 | September  $750.00 §245.00 $120.00 $111.00 $110.00 §298.00 $1,634.00

12 | October $750.00 §280.00 $99.00 §98.00 $110.00 $245.00 §1,582.00

13 |November $750.00 $400.00 $110.00 §56.00 $110.00 $405.00 $1,563.00

e

December $750.00 $415.00 $130.00 §34.00 $110.00 $505.00 $2,094.00

&




Paste a Range of Cells

0 Place the cursor where you want to paste

Ed Microsoft Excel - Monthly Expenses.xls

E File  Edkt | Wiew Insart  Format  Jools  Deba Window  Help

D) @ %7 Undo Tyning " in A2:HE

change shest name - X

(A G

1 1dey)

Excel places a copy of the copied cells

EEX

Ed Microsoft Excel - Monthly Expenses.xls

@x-fH @B -0,
the cells. ATS K Ok Chrk

. . 1By Copy il D ] F G H = **
@ Click EditeoPaste. Ay o v Ex@es Ny a
21 . 2l EleCricity  Child Care Misc. Total H (¢}
. 3 Jam,  Paste Teddl. §75.00 SE7OD  $110.00  §175.00 $1.411.00 p-e
You can also click the Paste button. 4 Febr  ShowDae $6800  SEOOD  §11000  §145.00 §1.453.000 -
5 Marc $000  §2900  §11000  $12300 141700} E‘

& April §7900  $10300  $11000  $211.00 $1.509.00}
7 iMay|  Cear Y0000 §1000  §11000  §34500 §1.722000 Vje}
8 Mune  pelers.. (05
4 LJuly ) §14500 §190.00  $15000 §1 568 00 oA
10 [Augy  Detote shest $13000  §11000  $296.00 $1655.00 S
11/Sepl  GoTo.. i §U1900 §1I000  §298.00 §1634 00 =1
12 Octo ¢ 5900 §5G00  $11000 324500 $1 56200 =
13 November  $75000  §40000  $11000  $EA00  §11000  $40500 §1863.00 o
0_ 14 December  §75000  §41500  §12000  §8400 11000  $605.00 5208400 au
s
=
rm
>
aQ
()
—

|n the new |Ocat|0n E Eile  Edt Miew Insert Format  Jooks  Dasba  Window  Help change sheet name | X
D8 LY fRR-F a- @ = -4 R e - (3
AlE - f
A [ B [ ¢ T o T E [T F [ &6 [ H [T
LI Monthly Expenses Hl
24 Rent Groceries  Fuel Electricity Child Care Misc. Total |
3 Nanuary §750.00 §214 00 §76.00 §E7.00 11000 $175.00 $1,411.000
4 EFchlual‘y §720.00 §311.00 $E5.00 $E9.00 11000 §145.00 $1 493.DDE
5 'March §7E0.00 §245 .00 §E0 .00 55900 11000 $Z300 $1.417 008
B April F720.0 $226.00 §79.00 F10G.00 1000 $211.00 $1.509.00
7 May §7e0.0 §307 00 §100.00 $110000 §1000 §34500 §1.722 .00
5"
) 5
10 August $720.00 F229.0 11000 12000 11000 $256.00 $1855.00
11 September 75000 24510 $120.00 $1171.00 F110.00 25800 $1 63400
12 |October §750.00 $2E0.00 §59.00 §55.00 11000 $245.00 $1562.00
13 mhber §7s0.00 4000 $110.00 SE3.00 11000 40500 $1.863.00
14 ember §750.00 G416 00 §120.00 SE4 00 F110.00 J605 00 §2 054 00
15| Rent Groceries Fuel Electricity Child Care Misc. Total
16 |l ¥ §780.00  g1400 §75.00 a7 #1000 §17500 1411
% February §750.00 §311.000 $ES.00  S.50E+D1 11000 F145.00 1455
March §7E000  §24500 §20.00 §99.00  §H000 2300 1417
19 ril §750.00 §256.00 79.000 $10G.00 F110.00 $211.00 1508} ., -
o> mhsheott (Shee2 (sress/ 4] o
Seleck: destination and press ENTER ar choose Paste Sum=18232 HUM

You can customize the way Excel pastes values by clicking Edit=>Paste Special. The Paste
Special dialog box displays several different options for specifying the content to paste as well
as what operations to perform during the paste.

If you select All, Excel pastes the entire contents of the copied cells. By selecting Values

(O changes to (®)), Excel only pastes the value of the copied cells ignoring any formulas,
comments, or formatting. If you only want to paste comments, data validation, or formats,
Excel does not modify the existing values in the cells to which you paste. If you paste formulas,
Excel only changes the values in the cells where you paste.

You can click one of the Operation buttons ((O) changes to (8)) to perform a mathematical
operation on the pasted data. For example, if you select Add, Excel adds the pasted values to
the existing values in the cells.

Click the Skip Blanks option ([_] changes to [v]) to prevent Excel from pasting a blank value
from a copied cell into a cell that contains a value.

When you click the Transpose option ([_] changes to [v]), Excel transposes copied values
from row to column or vice versa.




Create a Custom

Number Format

specific format, for example, three decimal places, you

can create a custom number format. With one
definition, you can control how Excel formats a positive
value, negative value, zero value, and text value. You can
use any combination of the four format types, but you must
place them in order and separate them with semicolons:

Positive Number Format;
Format;

I f you want the numbers in your worksheet to have a

Negative Number
Zero Value Format; Text Format

Excel applies one specified format for all four conditions. If
you specify two different formats, Excel applies the first one
to both positive and zero values, and the second to negative
values. The following example formats positive numbers

You create custom number formats using any combination of
the format codes with 0 and # being the most useful numeric
codes. You use O to define digit placement. For example, if
you type 000.000, Excel displays the value 670.45 as
670.450. The # tells Excel not to display insignificant zeros
in the value. You can use color names in square brackets to
define color formatting. For example, for red text, a popular
color for negative values, you type [Red] before the format.

You can place characters, such as parentheses, within your

format. For example, the following custom format displays

positive numbers with two decimal places and a dollar sign,
negative numbers in red and parentheses, zero values as 0,
and text in cyan. The format uses the $ , . and parentheses
symbols.

with two decimal places and a dollar sign, negative numbers
in red and parentheses, zero values as 0, and text in cyan:

$#,330.00; [Red] (s#,##0.00) ;0; [Cyan]

Create a Custom Number Format

S#,##0.00; [Red] ($#,##0.00) ;0; [Cyan]

E_Mil:romft Excel - Ch01-CustomFormat. xls

0 Select the cells you want to format. D) Ele Edt Vew Inert | Fomat | Tools Data Wndow  Help -8 X
DEEan &RE &'W%Lil 3o -0,
. u " 1 B » as *0 00 g cim »
Note: See the section "Select a Range of Cells el G0 E g::mn BARABEE LA T
. . B3 - i
for more information. S = - \ = E =
A 1 |
@ Click FormatoCells. 7 Job 5T
3 |January W Condtional Formatting. .. -
4 |February A Styde... 3
| 5 |March 234544 r 156 .
5 | April 234544 56,79 1234 BB5434 695533
7 ay 234544 34.45 111,44 245,66 2735.99
pune 234544 156 99,89 0 242093
B A1) 2345.44 2442 1009 112367  3814.21
10 [August 2345.44 -112.43 155.9 900,45 3289.36]
11 |September 2345.44 250,54 12023 141278 4128.99)
| 12 |October 2345.44 1356 -19.41 8759 3215.49)
| 13 |Movernber 234544 134 MA 1200.34 3679.78]
14 |Decemnber 2345.44 112 -5&.55 1221.45 3622341_
AL
The Format Cells dialog box displays. aal
@ It itis not displayed, click the Number tab. O i [ | o | o | st | |
’ Category: Sample
. A A General 2345.56
9 Click Custom in the Category list box. Herber
UrrEncy
Accounting General format cells have no
Date specific number Format.
Time
Percentage
Fraction
Scientific
Text
Special 1
CL.G[D& . |
o




A st of curtnt custom formats s
displays in the Type box. o
Turmber |Aig’1ment ] Forit | Border | Patterns | Fratection | =
@ Type the desired custom format in the Category: sanpie =
. Gerral $2,345.56 [¢’)
Type field. furber —
Currenc}f Type:
. peeouniing [fF#,#20.00; [Red) $#, ##0.003,0;[Cyan, <@ 6 e
O click OK. bae — -
Percentage 0 :I C)
Frackion 0,00 o
Secientific &80 -
Text | x,mrugu(# 40 q;r
Speci #R0_i#, \
[Clstom——— TRA N Mg 64 O =l =
el | 0
. . . %2)
Type the number Format code, using one of thefexisting codes as a starting o=t
paint. Q
-
-t
(€]
O 1 o &
| s
Excel applies the custom format to your B3 = fx|2345-56 | | | 5.*
- A E © D £ F ® H =
cell selection. i 2002 Eamings = m
2 Job Paper Route Lemonade & FHoyalties  Total N
| 3 |January $2,345.55  (4214.40) $55.04 81245780 $343388 a
4 |February 0 (§3400) §569.34  §535.34 o)
5 |March §2,345 44 $1560  $890.34 $325138 et
B |Agiil $2345.44  (§56.79) §12.34 $565434 $B95533
|7 |May §2.345 .44 §34.45 511144 524566 52736.99
B |June $2.345.44 §45 60 $99.89 0 5249093
9 |July §2345.44  $24420  $10090 $112367 $3B14.20
10 [August $2345.44  (§112.43) $155.90 $900.45 §3,289.36
11 |Septerber | $2 345 44 $250.54 $12023 §141278 5412399
12 | October 2 345 44 §1356  (F1941)  $B7500 $3215.49
13 [Movember | $2345.44  $134.00 §$1200.34 $3679.78
| 14 |December |_$2345.44  $112.00 (45655 8122145 $§3622.34
15 ) |

If you cannot find a default format
. DATE SYMBOLS DESCRIPTION
you want for dates and times, you

can create custom date and time d Use d to display days as 1-31 or dd to display days as
formats. To do so, you combine the 01-31. Use ddd for a three-letter day name abbreviation,
codes, presented in the tables, for Mon-Sun. If you want the entire day name, use dddd.

the day, year, month, hour, minute, m Use m to display months as 1-12 or mm to display months
and seconds. You can use these as 01-12. Use mmm for a three-letter month name

codes with any of the custom abbreviation, Jan.-Dec. If you want the entire month name,
number codes, such as the color use mmmm.

codes. For example, to display the y Use yy to display a two-digit year, such as 01 or yyyy to
date and time as 3:45 PM March display the entire year.

14, 2002 in green, you type:

Example: TIME SYMBOLS DESCRIPTION

G h:mm AM/PM dd, . . . .
Lo vy h Use h to display hours as 0-23 or hh to display single-digit
hours with leading zeros, such as 09.

M Use M to display minutes as 0-59 or MM to display single
digit minutes with leading zeros, such as 08. Make sure to
use a capital M, or Excel will view it as months.

s Use s to display seconds as 0-59 or ss to display
single-digit seconds with leading zeros, such as 05.

AM/PM Displays either AM or PM with the specified time.




Apply AutoFormat

to a Worksheet

f you want to quickly change the appearance of your
I worksheet, you can apply a predefined format. Excel
provides 15 different formats that create a table-like
layout for your data. The formats work best when your
worksheet contains row and column headings and totals for
rows and columns.

You select a predefined format from the AutoFormat dialog
box. At the bottom of the dialog box, you find six different
format options: Number, Borders, Font, Alignment, Patterns,
and Column Width/Height. By default, Excel selects all six
options for you. You can adapt any one of the predefined
tables by deselecting options to achieve the effect that you
want. For example, if you deselect the Font category, Excel
does not make any font changes. As you select or deselect
different formats, the AutoFormat dialog box reflects the
changes letting you view how the various options affect a
particular table format before you select it.

Apply AutoFormat to a Worksheet

Excel replaces any previously applied custom formatting
with those that you select in the AutoFormat dialog box.
For example, if you have previously selected Arial Black as
the font for the entire worksheet, and you apply the
Accounting 1 format, Excel changes the font to Arial, the
default font for the Accounting 1 style.

The cells that you select before applying a format greatly
affect how Excel applies that format to your worksheet. If
you select only one cell in a range of cells, Excel examines
the worksheet and applies the selected format to all
surrounding cells that contain values. As soon as Excel
encounters a row or column of blank cells, it no longer
applies the formatting. If you type values in the adjoining
cells after you apply the format, those cells automatically
receive the selected format. If you select a range of cells,
Excel only applies the selected format to those cells.
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Clicking Options in the AutoFormat dialog box displays a list of the format categories. You
can select or deselect these options before applying a format to gauge the effect they have on
your worksheet. The following table lists each format option and what it does:

CATEGORY DESCRIPTION

Number Specifies the formats for numeric values, such as which values receive
currency symbols. Selecting this category overrides any number formats
applied using the Number tab in the Format Cells dialog box.

Font Defines all font settings including font type, size, bold, italic, underline,
font color, and font effects.

Alignment Controls the alignment of the values within each cell.

Border Controls which cells have borders and specifies properties, including
line thickness and line color.

Patterns Defines the background design and color of the table.

Width/Height Adjusts the width of each column and height of each row to

accommodate the cell contents. In most formats, Excel makes all
columns the same width so that the values within each cell are visible.




Create a

Named S

f you consistently apply specific formatting options
I within a worksheet, you can use a named style to
simplify the formatting process. When you have a style
that contains the formatting you want, you simply apply that
style to selected cells within a worksheet. For example, you
can create a Stocks style the changes numbers to fractional
values and displays them in Arial 10 point font and bold.
The advantage of creating and applying style is that you can
update them to suit your needs. For example, if you want
your Stocks style to apply italics to your worksheet, you
simply modify the style, and Excel automatically updates the
formatting in all cells using that style.

You create styles from the Style dialog box by modifying an
existing style. Excel provides six default styles, which you
can select in the Style name field. Normal is the default

Create a Named Style

style Excel applies to all cells of your worksheet. The other
styles provide default Number formats for formatting
numbers with commas, currency, or percent.

You modify default style format options using the six tabs
in the Format Cells dialog box: Number, Alignment, Font,
Border, Patterns, and Protection. You can modify the
various properties of your style by selecting options in any
one of these tabs. For example, if you specify that you want
to center the text within the cell, the Alignment option
displays the value: Horizontal Center.

When you create a new style, it becomes a part of only the
existing workbook. To make the style available to other
workbooks, you need to create a template. See the section
"Create a Custom Template" for more information about
creating templates.

@ Sclect the cells where you want

B3 Microsoft Excel - ch01-Style.xls
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The Format Cells dialog box displays.

6 Make the desired formatting selections.
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Styles are most useful when you can easily
apply them to your worksheet, and using the
Style dialog box is the quickest way to do so.
Unlike Microsoft Word, Microsoft Excel does
not have the Style dialog box as a default
option on any of its toolbars. To add the
feature, click Toolst>Customize. In the
Customize dialog box, click the Commands
tab. In the Categories box, click Format. A list
of the available format commands displays in
the Commands box. Click the Style dialog box
and drag it to one of the toolbars displayed
at the top of your Excel window. You can now
click the down arrow on the toolbar and view
a list of available styles.

After creating a new style, you can apply

it at any location. To do so, select the cells
you want to change and click Insert>Style.
In the Style dialog box, click the down
arrow next to the Style name field and
then the desired style. The check boxes
under Style Includes correspond to tabs
from the Format Cells dialog box with the
corresponding setting displayed next to
the tab.




Create a

late

Custom Tem

f you frequently create worksheets with the same
layout, such as a weekly stock analysis report, you can
make a template to eliminate repetitive tasks. 7emplates

provide a desired layout complete with specific styles,

border settings, headers, footers, and even default text and
images, such as a company logo.

You create a template by designing a generic workbook that
contains the worksheet layouts you want and then change
any aspect of it to suit your needs. You can create custom
styles, number formats, customized macros, and formulas.
You can also specify custom column and row headings in a
template. For example, if you generate a budget worksheet
each month, you can create a Budget template that contains
the column headings for all expenses and includes formulas
for summing the totals. See the sections "Create a Custom
Number Format" and "Create a Named Style" for information
on creating custom styles and number formats. See Chapter 4
for information on creating formulas and Chapter 9 for more

Create a Custom Template

about macros. Your custom template can contain settings for
the entire workbook. For example, if you only want the
workbook to contain one worksheet, you simply remove the
other worksheets before saving your template.

You can now save your generic workbook as a template.
On the Save As dialog box, you select the Template (*.xIt)
option in the Save as Type field. The option may also
appear as Template. When you do so, Excel specifies a
default storage location similar to the following:

C:\Documents and Settings\user name\
Application Data\Microsoft\Templates

Your drive letter may differ, and you must replace user name
with the username you use to log in to Windows. You should
allow Excel to store your workbook in the default location.
This ensures that the template appears in the General tab of
the Templates dialog box when you create a new workbook.
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The Templates folder displays as the
storage location in the Save In field.

0 Type a name for your template.
@ Click Save.

® Excel creates the specified template.

Save As

Save in:
<3
Histary

e

My Docurents

Favaribes

2=

Iy Netwark:
Flaces

e

| ) Templates

~le-m @

Tools =

Flepame:  [Expenses] 4t 4—9

=
Save as bype: |TemDIare (k) j Canicel

E Microsoft Excel - Expenses.xlt

Eﬂ_] File Ede Yiew Inssrt  Format  Tools  [Data  Window  Help -8 X
DEESY SRY $Ba - BE-4E @S -0,
Al -0 - B I UEEEE B%, BN EE -b- S
A2 - i3
A =] C D E 7 G H =
1 Clothing Auto Repair Auto Fuel Child Care Entertainment Total
2
3
4
5
B
7
] W
]
10
11
12
13
14
15

following location:

new worksheet.

When you create a new blank workbook, Excel uses the default system settings to create it — the
default font settings and three blank worksheets. Excel uses the system default settings as long
as a default workbook template does not exist. If you consistently make changes to every new,
blank workbook, you can make a default workbook template that always loads.

To do so, you first create a workbook that contains all your desired format settings, custom
macros, formulas, and a default number of worksheets. When you save the workbook as a
template, name it Book.xlt and save it in the XLStart folder, which is typically located in the

C:\\Program Files\Microsoft Office\OfficelO\XLStart
Each time you create a new workbook, Excel uses the default Workbook template you modified.

You can also create a default worksheet template by clicking InsertzoWorksheet. You must save
the worksheet template in the same location as the workbook template, but name it Sheet.xls.
Excel copies the contents of the Sheet.xls worksheet into your workbook each time you add a
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Protect

Worksheets

f you intend to share your worksheet with other users,

you may want to password protect it to ensure that users

cannot alter values in individual cells. By protecting the
worksheet, you ensure that the integrity of the data remains
intact, no matter who views the worksheet contents.

To protect a worksheet, you use the Protect Sheet dialog
box. Excel requires you to specify a password to protect and
unprotect the worksheet. Use a password that you can
easily remember; after you apply a password to a
worksheet, no one, including you, can alter the worksheet
without specifying the appropriate password. After you
unprotect a worksheet, it remains that way until you protect
it again.

The Protect Sheet dialog box gives you further control over
others' actions by allowing you to specify the functions that
users can perform while the worksheet is protected. There

Protect Worksheets

are fifteen different options from which to choose, including
locking and unlocking cells, formatting, and inserting or
deleting cells. If a user attempts to perform a task that is
not allowed, Excel displays a message box indicating that
the worksheet is protected. In order for users to make any
modifications to a protected worksheet, they must unprotect
the worksheet with the appropriate password.

By default, Excel applies allow the user to select both locked
and unlocked cells. When users select a protected cell, they
can view the contents of the cell in the Formula bar. If you
have created formulas that you do not want others to view,
you should make sure both of these options are not
selected. If users select an unprotected cell, they can modify
the cell in the Formula bar.

E3 Microsoft Excel - Ch01-ProtectSheet.xls
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The Confirm Password

(@)
dialog box displays. Confirm Password g
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Excel displays a message
box if the user attempts to
alter a protected portion of
the worksheet.

Microsoft Excel E|

N

The cell or chart wou are trying to change is protected and
therefore read-only.
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To modify a protected cell or chart, First remove protection using
the Unproteck Sheet command {Tools menu, Proteckion submenu),
You may be prompted For a password.

If you want to modify a protected worksheet,

you must click Tools=>Protection=>Unprotect

Sheet. In the Unprotect Sheet dialog box, type
the password that locks the worksheet in the

Password field and click OK.

By default, Excel allows you to lock all cells of
the worksheet, so that users can view the cells'
contents without altering it. You can unlock
certain cells in the worksheet so that users can
input values, such as sales total, so that
formulas in other cells can perform calculations.

You specify the lock status of a cell in the
Protection tab of the Format Cells dialog box.
Select the range of cells to unlock, click
Format=>Cells to display the Format Cells dialog
box, and then click the Protection tab. Click the
Locked option to unlock the selected range of

cells ([v] changes to []).

You can also select the Hidden options, which
hides the contents of a cell in the Formula bar if
a user selects the cell. This ensures that a user
cannot view special formulas. Just like the
Locked option, the Hidden option only takes
effect if you protect the worksheet.




